
PART ONE

Getting
Started



Before you can create games, you must learn to program, but before you can program in
Flash ActionScript, you must learn to use the Flash authoring tool. ActionScript is built on
this tool, so the first order of business is to learn all its basics. We follow that with the basics
of ActionScript programming. From there, the games will start popping out like popcorn.

This part contains two chapters that lay the foundation that is necessary for game program-
ming. What follows is a brief rundown of those chapters:

■ Chapter 1, “The Flash Authoring Tool,” gives a breakdown of the various tools and windows
that are associated with the authoring tool. After reading this chapter, you will have a good
idea about how to do things like create movie clips, import graphics, create simple Flash
movies, and publish finalized Flash movies from your authoring tool. This chapter covers only
the parts of the authoring tool that are essential to game programming. This chapter should
be supplemented with the built-in tutorials and Flash manual. 

■ Chapter 2, “Flash ActionScript,” introduces you to the ActionScript programming language
that is embedded in Flash. This language is your primary tool for creating interactivity in your
Flash movies and will serve as your greatest ally in your quest to build video games. This chap-
ter focuses on how to write scripts and how to attach them to movies. It also introduces some
of the simplest ActionScript elements..



CHAPTER 1

The Flash
Authoring

Tool



We are now ready to delve into the authoring tool and talk about what it does and
how to navigate in it. If you have not done so already, open Flash MX. If you have

never opened Flash before, you’ll see a screen that asks you about your default panel lay-
out. Go ahead and cancel out of this screen.

You’ll notice several windows open on your screen, and if you’re like me, you might be say-
ing “Wow, that’s a lot of stuff!” But never fear—it’s actually quite simple, and you’ll soon
have a clear idea of what all those windows are about and what they can do for you. By 
the end of this chapter, you should have no problem creating simple movies in Flash. You
won’t have much interactivity with the user, but that will come later. For now, let’s look at
our new tool.

Interface
The Flash authoring tool is broken down into panels. Different actions that you want to per-
form are available in different panels, and each panel has a series of actions that you can
perform inside it. These panels help to group similar actions together. For example, Figure
1.1 shows the Color Mixer. It lets you alter the colors of certain pieces of art in your movie.
It has a color selector that you can pick colors from as well as a numerical input that you
can use to specify the exact Red Green Blue (RBG) values that you want.

One thing that is important to note is that all of these panels can be moved around. If you
drag the panels by the upper-left corner of their title bar, you can position them anywhere
you like, even outside of the authoring tool’s window. If you have multiple monitors
attached to your computer like I do, you can actually drag some of the panels onto your
other monitor to free up some space.
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Figure 1.1

The Color Mixer panel allows you to change the color of things.



In addition to dragging panels around, you can collapse them, as in Figure 1.2. Clicking on
the title bar of a panel collapses that panel. To reopen a panel, you simply click the title bar
again. This allows you to free up space by collapsing panels you don’t need.

If you find yourself in need of a collapsed
panel, you simply reopen it, use it, and then
collapse it again. The sheer number of pan-
els available in Flash makes this feature
indispensable. You’ll find your desktop
quickly clogged with panels if you don’t take
advantage of this collapsibility.

Finally, you can use the Window pull-down
menu to add and remove panels from the
Flash tool. If there is a panel that doesn’t get
used, consider getting rid of it completely with this pull-down menu. You can always get it
back by selecting it from the Window pull-down menu again. 

The layout of panels in your Flash tool is called a panel set. Panel sets can be saved. If you
have spent time getting your panels positioned like you want, you should save this layout by
using the Window pull-down menu and selecting Save Panel Layout. You can later load that
panel set from the Window pull-down menu by selecting Panel Sets and then selecting the
panel layout you saved by name. You’ll find that your panels are all back where they had
been when you saved them.
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Figure 1.2

Panels can be collapsed when
they’re not being used, so they
don’t waste desktop space.

TIP
If you want to collapse all the panels
bordering one side of the document,
click on the white arrow at the edge
of the group of panels to collapse
the whole group.



Creating a New Movie
The first thing you need to do when you want to create a new game or Web site is to create
a new movie. To do so, use the File pull-down menu and select New. A menu appears allow-
ing you select the type of document you want to create. This menu has several templates
available as well as some new choices that we will see throughout this book. For now, select
the first option, Flash Document. This creates a new file with the .fla extension. This is a
Flash source file, which is your primary file type for using Flash. The new movie you just
created contains essentially nothing. It has no art or scripts; it’s simply a blank canvas for
you to create content on.

The Stage
The most important area to you is called the stage. This is a centrally located window with
some scrollbars on it and a solid white background. Take a look at Figure 1.3 to identify 
the stage.
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TIP
It is often more convenient to use the keyboard instead of the pull-down menus.
Nearly every action in Flash can be executed with a keyboard shortcut—and gen-
erally much more quickly than with the menus. Because keyboard shortcuts dif-
fer between platform and even between developers on the same platform, I will
not be giving keyboard shortcut examples in the text. Instead, I encourage you to
use Flash’s built in keyboard shortcut organizer. If you use the Edit pull-down
menu and select Keyboard Shortcuts, you will see a dialog box that has several
options. If you have trouble figuring out this feature, simply click the Help button
in the lower-left corner to access the Flash documentation on the subject.



The stage is where you can actually see your creation coming to life. You can place art
(when you have some available) on the stage and move it around. You can color the stage,
resize it, and manipulate it in many ways, as you will see soon. For now, we have nothing to
place on the stage, so we’ll leave it alone. As soon as we have created some art for our
movie, we’ll place it on the stage. Then we can watch the magic happen.

There is a gray area surrounding the stage that represents an off-stage area. You can place
objects here, but they will not be displayed in your final movie. Sometimes it’s convenient
to place an object offstage and then slide it in when it’s time for its appearance. We’ll see
how to do both of these tasks very soon.

The Tools Panel
Another important panel is called the Tools panel, or Toolbox. Use the Windows pull-down
menu to open this panel if it’s not already visible. It’s usually on the left side of the author-
ing tool and can be seen in Figure 1.4.
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Figure 1.3

The stage is where all the action happens.



The Tools panel is useful for creating art within Flash, but before we do that, we need to
create a new object to hold our art. Use the Insert pull-down menu and select New Symbol.
You should see a dialog box as in Figure 1.5, with the name of the symbol already set to
Symbol 1 and the behavior set to Movie Clip.

Change the name from Symbol 1 to Ball and click OK. This action has created a new movie
clip and opened it for editing. Now it’s time to draw some stuff.

Look back at the Tools panel and click on the white circle with the black outline. This is the
Oval tool, and it is labeled in Figure 1.4. If you move your mouse over the stage, you’ll see
that your pointer has turned into a crosshair. Click and drag with the mouse and create a
small circle. When you release the mouse button, the circle is drawn on the stage. Now look
at the top of the stage. You should see two icons with text that look like Figure 1.6.

8 1. The Flash Authoring Tool

Figure 1.4

The Tools panel allows you to select and manipulate
objects on the stage as well as create original art.

Figure 1.5

The Create New Symbol dialog box is used to
create new objects and art assets.



The word Ball is in bold because you are editing it. Now click on the Scene 1 icon. This tells
Flash that you want to stop editing your Ball movie clip and return to the main movie,
where you were before you created the Ball movie clip.

You’ve created a movie clip called Ball that contains a black oval on a white background.
The new clip has been saved for you and exists as a symbol in your library.

The Library
The library is a repository for all your art and sound. All the raw materials that you need to
create games are stored and organized in the library, and you’ll quickly become familiar
with its use. Use the Window pull-down menu and select Library to open the library panel. 
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Figure 1.6

The top of the stage has icons that
represent different timelines you have
open for editing—in this case, Scene
1 and Ball.

Figure 1.7

The library is a storehouse for all your Flash assets, including
art, sound, movie clips, buttons, animations, and the like.



This new panel, shown in Figure 1.7, has a
list of all the symbols in your movie along
with an icon showing you their type. You
should see the Ball movie clip as the only
element in the library. 

Click on the ball symbol and drag it onto
the stage. This creates an instance of the
ball movie clip. It’s important to note that
the ball we edited was a template for all
possible balls instances in our movie. If we
were to edit the ball symbol again and say,
change the color from black to red, the
ball instance on our stage would change
color as well because it is only an instance
of the ball symbol that exists in our library.

Go back to the Tools panel and select the
black arrow in the upper-left corner. This 
is the Arrow tool, and it is labeled in 
Figure 1.4.

The Arrow tool is used to select and move
stage elements around. With the Arrow tool
selected, you can move your mouse over the
ball on the stage. You should see the mouse
pointer change to an arrow with a small 4-
way arrow next to it, as in Figure 1.8.

The change in the mouse pointer is telling you that if you drag the object below your
mouse, it will move. Try dragging the ball around the stage a bit.

Now drag two more instances of the ball from your library onto the stage and position them
anywhere you want to on the white background. Put your mouse over one of them, right-
click, and select Edit from the pop-up menu. This allows you to edit the ball movie clip
again. Look back at the Tools panel and select the Paint Bucket icon. It’s about halfway
down on the right side of the Tools panel, and it’s been labeled in Figure 1.4. 
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TIP
TYou can create folders in your
library to help organize your sym-
bols. Click the folder icon, shown in
Figure 1.7, in the lower-left corner of
the library to create a new folder.
After giving the folder a name, you
can drag and drop library elements
into and out of the folder. If you click
on the icon to the left of the folder’s
name, you can open and close the
list of symbols within that folder.
This allows you to more easily navi-
gate through a long list of available
symbols.

CAUTION
Be careful when you are placing
movie clips on the stage.The actual
stage is only the part with the white
background.The gray area surround-
ing it is out-of-bounds; movie clips
placed there will probably not
appear in your final movie.

Figure 1.8

The mouse pointer changes when you are ready to drag an object on the stage.



Further down the Tools panel, you should see two color selectors called Stroke and Fill
color. These icons are also labeled in Figure 1.4.

Click on the lower icon, which is used to change the color of filled areas. You should now
see a color selection palette with several different colors to choose from. Pick a reddish
color and then click on your ball. You should see the ball’s interior become red.

Now select Scene 1 from the top of the stage to go back to your main movie. Notice that all
the balls are now red. That’s because when you right-clicked and edited the ball, it actually
opened the ball movie clip from the library for editing. Because all the balls on your stage
are created from the same symbol, when you changed that symbol’s color, all the balls
changed to match.

Importing Graphics and Sound
In addition to creating new movie clips from scratch, you can import graphics and sound
from outside sources. Flash can import from a wide variety of file formats, allowing you to
create art and sound outside Flash and then bring them in with a few mouse clicks.

Our plan is to import a bitmap graphic from the CD to use in our movie. But first we must
create a movie clip to import the graphic into. Select New Symbol from the Insert pull-
down menu and name the symbol veggie.

Insert the CD into your drive and then use the File pull-down menu to select Import and
Import to Stage. Navigate into the CD drive and then into the Chapter 1 folder. Choose the
file named veggie.bmp and click OK.

You have now created a new movie clip named veggie and imported a graphic into it.
Notice that the veggie.bmp file is now included in your library. The graphic you see on the
stage with the gray outline is an instance of the veggie movie clip. Select Scene 1 to stop
editing the veggie and return to the main movie stage. Now drag an instance of the veggie
movie clip from the library onto the stage.

Make sure to drag an instance of the veggie movie clip from the library to the stage and not
an instance of the veggie.bmp graphic. If you drag an instance of a graphic onto the stage,
there is no way to control it with script; by placing it inside a movie clip and then dragging
the clip onto the stage, you leave yourself the option of using script to affect it later.

In your library, different symbol types have different icons. Figure 1.9 shows each of the
symbol types with the respective icons.
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To import sound, you would follow a similar
procedure, except that you wouldn’t need a
movie clip to contain the sound. That’s
because you don’t drag sound files onto the
stage; instead, they stay in the library and
you trigger them with ActionScript.

Text Fields
As you might expect from a program used
to develop Web sites, Flash comes with some
powerful tools to add text to your movies. By
creating what is called a text field, you can easily add several kinds of text elements to your
work. Text fields come in three types:

■ Static text. This is text that will be displayed and will never change. After you enter this text, it
stays exactly as you entered it for the life of the text field. Most text is static text.

■ Dynamic text. This is text that can be changed over the life of the text field. Dynamic text is
typically used to display dynamic information in a game. For example, a player’s current score
is one good use of a dynamic text field. The player’s score changes as he completes tasks in
the game, so the value displayed in the box must change. By using a variable, you can allow
Flash to automatically update the contents of your dynamic text field when things in your
game change. (You will learn about variables in Chapter 2.)

■ Input text. This is text that the user can change while playing your game. Many times the user
needs to enter some information, such as his nickname. By creating an input text field, you
can give him a place to type the information. In a similar way to dynamic text, input text is
associated with a variable. When the user changes the text in the input text field, your pro-
gram will know about it. That way, your script can monitor what the user has entered into the
input text field and act appropriately. A good example of an input text field in a game is a
form for the user to enter his nickname so that you can post his name and score on a high-
score board.
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Figure 1.9

Different symbol types have different icons
for easy identification.

TIP
You should be aware that you can
also import finished Flash movies
into a new movie. If you create a
small Flash movie and you want to
use it as part of a bigger Flash
movie, you can. Simply import it like
any other outside element.



Because both dynamic and input text fields
require the use of ActionScript and we have
not covered any of that yet, I’m leaving an
explanation of those types of text fields
until we are ready for them. For now, let’s
look at the creation of static text fields.

Static Text
Fields
To create a static text field, begin by selecting the Text tool from the Tools panel. This icon
has the letter A on it and is labeled in Figure 1.4.

After pressing the Text tool, left-click somewhere on the stage. Now type some text into the
box that has just appeared. You can resize the text field by dragging the lower-right corner.
You can also reposition the text field by putting your mouse over the edge of the box so
that the mouse pointer turns into the little four-way arrow that indicates a draggable object.
Then drag your new text field anywhere on the stage you like.

After you are content with the text in your static text field and its position, select the Arrow
tool from the Tools panel. That causes you to leave Text Entry mode on the text field and
go back to being able to select different stage elements.

We should now talk about another important tool so that we can use it to change the
way our text field looks. You manipulate things like text size or font type through the
Properties panel.

The Properties Panel
One of the most important panels in the authoring tool is called the Properties panel. It’s a
short, wide panel that looks something like Figure 1.10. It’s possible that your Properties
panel might look somewhat different from the one in the figure. Let me explain.
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TIP
Text in Flash is normally anti-aliased,
meaning that small fonts have a ten-
dency to be a bit blurry.A new fea-
ture in Flash allows you to make text
fields aliased by pressing the Alias
text button while you have one or
more text fields selected.

Figure
1.10

The Properties
panel allows
you to edit
properties of
anything on
the stage.



The Properties panel is adaptive in the sense that when you select an item on the stage, the
contents of the Properties panel change to reflect properties of the object you selected.
Different types of elements on the stage have different properties, and the Properties panel
changes to reflect that. For example, movie
clips have a position and a size property in
the panel, and although text fields have
these two properties as well, text fields also
have properties that a movie clip does not,
such as font, font size, and kerning. When
you select a movie clip on the stage and
then look at the Properties panel, you see
only the properties that pertain to a movie
clip. If you select something else, such as a
text field, you see all the properties avail-
able for that, which include font.

When you’re using the Properties panel to
manipulate stage elements, the properties
pertain to the instance on the stage, not to
the symbol in the library. That means that if
you have five ball instances on the stage
(remember when we created ball instances
earlier this chapter) and you increase the
size of one ball on the stage by selecting it
and altering the fields in the Properties
panel, only the selected ball changes. The
symbol in your library is unaffected, as are
the other balls on the stage.

Now that you know what the Properties panel does, go ahead and click on the text field
(the one we created a couple sections ago) if it is not already selected. Now look at the
Properties panel and compare it with Figure 1.11. Notice that the font, font size, auto-kern-
ing, and several other text properties are available to you now. The upper-left option
defines the type of the text field and is labeled in Figure 1.11 as well.
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CAUTION
Don’t confuse the use of the
Properties panel to change an
instance with actually editing the
library object, which is done by
right-clicking on a symbol or
instance and selecting Edit.

CAUTION
Make sure that when you try to
change the properties of an instance
that only one instance on the stage is
selected. If you have more than one
instance selected and you try to
change some properties, Flash will
apply all the properties to all the
instances.

Figure 1.11

The Properties
panel shows
properties for a text
field when one is
selected.



Because we only know how to use static text, make sure that’s the type defined for this text
field. Below that are the position (X and Y) and size properties (W and H). Try changing
those four blanks and see what happens. Two of them, labeled W and H, should change the
scaling of the text field on the stage. The other two blanks, labeled X and Y, should change
the position of the text field. There is also a block of properties that include the font, font
size, color, bold, italic, centering, aliasing, and so on. Feel free to experiment with these 
different text options and consult the tutorial if you have problems. You can also check 
the Selectable text field on the Properties panel if you want your user to be able to high-
light and copy text in your game or Web site with the mouse. Selectable text is labeled in
Figure 1.11.

Selectable text is useful if the user needs to copy and paste text from your site to some-
where else. There is also a URL Link field, labeled in Figure 1.11, where you can define a
hyperlink to another site. If you place a URL in this field and the user clicks on the text
field, the user is redirected to whatever URL you filled in.

Finally, you can use the Properties panel to change some of the properties of the main
movie. If you click somewhere off the stage or somewhere on the stage where there are no
movie clips, your Properties panel shows the main movie Properties. This can be seen in
Figure 1.10.

The Size field indicates the size that the movie will be in the Web browser when it’s pub-
lished. Whatever size you set this to is reflected by the size of your stage background. The
next field is labeled Publish. It determines
which Flash Player your final movie is
playable on. The new ActionScript features
introduced with version 6 of the Player
don’t work if you publish for anything other
than Flash 6. Therefore, we won’t change
this field in any of our games. Essentially,
the only reason to use Publish is if you don’t
have the Flash 6 ActionScript commands
and you want users who have older versions
of the player to be able to view your movie
without downloading the latest player from
Macromedia.

Although the Properties panel provides many properties to fiddle with based on the stage
object we select, it only lists the most commonly used properties. To access all possible
properties of an object, you must use some additional panels. One excellent example of this
is the Transform panel.

The Transform Panel
The Transform panel allows us to scale, rotate, and skew instances, or groups of instances,
on the stage. You can view the Transform panel in Figure 1.12.
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TIP
You are encouraged to search
around and discover other options
and properties in Flash. Rolling up
your sleeves and getting your hands
dirty is an important part of the
learning process.



The top two fields indicate the scale of the
selected object. Click on one of the balls on
the stage and open the Transform panel.
Both fields are set to 100, which means the
clip is being displayed at 100 percent of its
normal symbol size. If you change one of
the numbers to 200, the ball doubles in size.

The next field in the Transform panel is
labeled Rotate. This field allows you to
rotate a movie clip instance on the stage by
simply changing the number. Try selecting
the veggie instance and changing the Rotate
field from 0 degrees to 180 degrees.

The final field in this panel is labeled Skew.
This value is best explained with an example. Select one of the balls on the stage and look
at the Transform panel. Click on the Skew option button and enter 20 in the first blank.
Notice how the ball you selected is stretched.

Play around with stretching, scaling, rotating, and skewing some of your movie clip
instances. Feel free to drag more balls and veggies from the library if you need more raw
materials to experiment on. Figure 1.13 shows some clips being skewed.
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Figure 1.12

The Transform panel allows us to scale, rotate, and skew a movie clip
instance on the stage.

TIP
If you uncheck the Constrain check
box and then alter one of the scale
values, only one of the dimensions is
scaled, giving you a stretching effect.
This is in contrast to the default
value, in which Constrain is checked.
When this is the case, the value you
didn’t change is automatically scaled
along with the value that you did.

Figure 1.13

The skew property
allows you to do some
strange-looking
stretches. It uses an
angle measure for its
calculations.



The Timeline
Directly above the stage is a panel called the timeline, which can be seen in Figure 1.14.

In Flash, every movie has a timeline, and the timeline’s job is to tell the movie what to do.
The timeline is broken down into several pieces, including frames, the playhead, keyframes,
and layers. Let’s look at each piece.

Frames
You should see a long row of thin white rectangles, labeled in Figure 1.14, which represents
the frames in your timeline. Each frame represents one slice of time during movie playback.
Flash plays each frame in a timeline, one at a time, in succession. By placing different
objects and scripts in various frames, you can control what happens during movie playback.
At any given moment of time, Flash will be working in one frame of the timeline.
Whichever frame is the current one is said to have the playhead over it.

The Playhead
The playhead is labeled in Figure 1.14. This pink rectangle tells you which frame is cur-
rently being displayed on the stage. By dragging the playhead left and right, you can
change the currently displayed frame on the stage. During movie playback, the playhead
will move from frame to frame, displaying stage instances and executing scripts attached to
the frames it passes over. (Attaching scripts to instances is covered in Chapter 2.)

Right-click on frame 10 in the timeline and select Insert Frame. This adds new frames to
the timeline and automatically moves the playhead into the last frame. You can now drag
the playhead into any of the frames in the timeline and see the contents of the stage during
that frame. Any time you add an instance or alter something on the stage, you must make
that frame into a special kind of frame called a keyframe.
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Figure 1.14

The timeline breaks down a
movie clip into frames.



Keyframes
These are special frames where things
change on the stage. When a keyframe is
present on a timeline, the frame gets a
black dot inside, as in Figure 1.14. You can
add a keyframe by right-clicking a frame
and selecting Insert Keyframe. Inside a
keyframe, you can place art on the stage.
The art will appear to the user when his
movie has reached that frame.

You can add a keyframe by selecting either
Insert Keyframe or Insert Blank Keyframe. If you insert a keyframe, you get a copy of any
objects on the stage in the last keyframe before the frame you are adding a keyframe to.
This is convenient if you want to make small changes to the position of objects on the stage.
If you add a blank keyframe, you don’t get copies of the art; instead, you get a blank stage
in that frame.

As you can probably tell, if you are creating an animated movie or something similar, you’re
going to have a vast number of art objects on your stage in any particular frame. This begs
for a system of organization for the art objects, and Flash gives us one. It’s called layers.

Layers
Layers are primarily a method of organizing objects on your stage. If you look at your time-
line, you’ll see one layer that is labeled Layer 1. You can see this by referring to Figure 1.15.

All new movies have just one layer, but you can add more by pressing the Add button in the
lower-left corner of the timeline. Press that button now to add a second layer to your main
movie timeline. When you drag an instance of a movie clip onto the stage, it is assigned to
whichever layer is currently highlighted.

Layers give us some tools for working more efficiently with our stage instances. Layers can
be locked, hidden, named, and ordered. These are all important concepts, so let’s look at
each of them.

18 1. The Flash Authoring Tool

NOTE
A keyframe is used when something
on the stage changes, such as a new
instance appearing or an old
instance disappearing.When you
want the stage to remain as it is, you
will use regular (blank) frames
instead of keyframes.

Figure 1.15

The timeline has layers that can
be locked, hidden, named, and
ordered.



Locking Layers
Each layer can be locked so that any movie clip instances on it cannot be moved or deleted.
This allows you to create complex scenes in your movie and not mess things up by acciden-
tally dragging the wrong clip around the stage. To lock a layer, simply click on the dot to
the right of the layer’s name that is below the little lock icon, as seen in Figure 1.15. This
causes the layer to lock, which is indicated by a red X where the dot used to be. To unlock a
layer, simply click the red X.

Hiding Layers
You can also hide a layer if you need to. When you hide a layer, it still shows up in your 
final movie, but it is hidden while you are authoring. This is convenient when you have
many clips on the stage and things are getting too chaotic. If you hide some of the layers,
you can see the clips that you are trying to arrange more easily. To hide and reveal layers,
click the dot that is to the right of the layer name underneath the eyeball icon, as shown
in Figure 1.15.

Naming Layers
You can change the name of a layer by double-clicking its name. Try to name layers based
on the kind of content you plan to place in them. By giving layers good names, you can eas-
ily find your content in the timeline even when you have hundreds of clip instances inside
dozens of layers.

Now that we’ve seen the majority of properties of the timeline, we’re ready to move on.
From here, we’re going to look at more of the objects that we can use on our stage, as well
as the ability to add text to the stage.

Ordering Layers
Another important feature of layers is that you can drag them up and down in relation to
each other. The stacking order of movie clip instances on the stage reflects the ordering of
the layers in the timeline. In other words, if some of your movie clip instances are overlap-
ping on the stage, you can change which one is on top by changing the layer order. Right-
click on the veggie movie clip instance on the stage and select Cut from the pop-up menu.
Now click the Insert Layer button in the lower-left corner of the Timeline panel. The icon
is labeled in Figure 1.15. A new layer should have appeared above Layer 1 called Layer 2.
This new layer should also be highlighted. Right-click on the stage and select Paste from the
pop-up menu. This should paste the veggie movie clip instance onto the stage in the first
frame of Layer 2. Drag the veggie clip around the stage until it’s sitting on top of one of the
balls. Then go up into the timeline and drag Layer 1 down below Layer 2. Notice that the
veggie movie clip is now sitting below the ball because the layer order changed. Putting
clips into separate layers allows you to easily manipulate the stacking order of clips on 
the stage.
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Frame Labels
Now that we know about the Properties
panel, we can go back and cover one more
topic about the timeline: frame labels. One
additional thing you can do to a frame is
give it a name. That’s really kind of silly at
this point, but in the future, we’re going to
use those frame labels (names) to do some
neat stuff with the playhead. At this point, I
just want to get us to the point where we
can name frames.

Add a new layer called labels. Select the first
frame in its timeline, and look at the
Properties panel. Notice the blank with
<Frame Label> in it, as shown in Figure 1.16. 

If you type a name into this blank, the frame is named. Try typing a name into that field
now. When you have labeled a frame, a small red flag appears in the frame you labeled, as
shown in Figure 1.17. 
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TIP
You can use folders to organize your layers, much like you did with symbols in the
library. In some movies, you might have dozens of layers, and organizing them
into folders that you can open and close will help you keep everything straight.

NOTE
Remember that when you create a
new layer, the first frame will always
be a keyframe.You can only add
frame labels at keyframes; therefore,
if you want to label a frame other
than the first frame in a layer, you
must add keyframes where you want
the labels to go.

Figure 1.16

When a frame is
selected, the Properties
panel has a field used
to name it.



The name also appears in the frame, but
only if there are enough blank frames fol-
lowing the labeled frame to give adequate
room to display it. Add blank frames after
the frame you labeled if you cannot read
the name. After the blank frames have been
added, you should be able to see the label,
as in Figure 1.18.
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Figure 1.17

A labeled frame contains a red flag to let you know it has a
name.

NOTE
You are not required to put frame labels in their own layer, but doing so makes
your movie more organized. I always make a Labels layer, and it’s always the top-
most layer in my timeline.

TIP
You don’t need to be able to see the
frame label for it to work. If you
move the mouse pointer over a
frame with a label that is obscured, a
ToolTip will appear that tells you the
name of that frame.

Figure 1.18

If blank frames follow a labeled frame, the name is displayed in
the timeline.



Scenes
You can break up a Flash movie into scenes. Scenes are essentially breaks in your timeline
in which the numbering of frames starts over at 1 again. In general, artists and animators
use scenes as logical breaking points in their animated movies, but for the video game pro-
grammer, scenes serve no real purpose. Using scenes only causes a programmer to break
his scripts into pieces and place some of them in one scene and some of them in another.
Because one of the things a Flash programmer tries to do is keep all his code in one place,
scenes are counterproductive. For that reason and many others I won’t waste time mention-
ing, none of the games or code in this book uses anything more than the default Scene 1.

Adding a Simple Tween
We should now add something to our movie that will give us some action. I’m tempted to
give you a couple lines of ActionScript to make an instance move about the stage, but that
topic is probably best left to the next chapter, which is getting close now anyway. Instead,
we’re going to do something that we’ll probably never do again: tween. Tweening, as you
might have read in the tutorials, is a tool that creates motion in Flash. Specifically, a
designer places a movie clip on the stage in a particular frame on the timeline. The
designer tells Flash to tween the movie clip. Finally, the author changes the position, orien-
tation, size, shape, and so on, of the movie clip at some frame further down the timeline.
When the final movie plays, Flash fills in the frames in between, and changes to the clip
become fluid over time. An example will help explain this concept.

Click on and delete any instances on the stage. Now create a new instance of veggie by
dragging it onto the stage from the library. (If you don’t have veggie in your library, go back
and reread the section on importing graphics and sound.) Click on the veggie instance on
the stage. Now go up to the timeline and notice that the layer that contains veggie is high-
lighted. I know this is true because when you select a clip on the stage, the layer it exists in
is automatically selected in the timeline. Use the Insert pull-down menu and select Create
Motion Tween. Now right-click on Frame 20 in the highlighted layer and choose Insert
Frame from the pop-up menu. Don’t insert a keyframe—just a normal frame. This action
causes Flash to add an empty frame to the twentieth frame in the timeline and to fill all
frames in between with empty frames. Finally, with the twentieth frame highlighted (it
should be selected if you haven’t done any other clicking around on the timeline), drag 
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NOTE
You can only label keyframes. If you try to label a normal frame, the label is
applied to the previous keyframe in the timeline. Frame 1 always contains a
keyframe.



the veggie instance somewhere else on the stage, as far away from its current location as
possible. This completes the tween. Veggie now moves across the stage when the movie is
played or previewed.

Previewing a Movie
You can use Flash to preview your final movie by selecting Play from the Control pull-down
menu. You should see veggie sort of sliding across the screen while the pink playhead
moves down the timeline. When the playhead gets to the end of the movie, it stops. You
should also notice that the balls and text field disappear while veggie makes its journey
across the stage. That’s because there are no empty frames after the balls’ keyframe in their
layer of the timeline. You can right-click on the twentieth frame in Layer 1 and select Insert
Frame to fix this if you want to.

Testing a
Movie
The most common way to see your work in
progress is to test your movie. You can do
this by selecting Test Movie from the
Control pull-down menu. During testing,
Flash will play the movie inside the author-
ing tool’s window for you. This is the fastest
and easiest way to see your work in progress,
and we’ll be using it extensively later in 
the book.

Publishing a
Movie
After you have completely authored a movie
and it’s ready to go up on your Web site,
you need to tell the authoring tool to pub-
lish it. This takes the .fla file that was cre-
ated when you started the chapter and
converts it into an .swf file. An .swf file is
playable in the Flash Player, which embeds
in the Web browser. The sole purpose of the
authoring tool is to allow you to create .fla
files and then convert them into .swf.
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CAUTION
Don’t be confused about the differ-
ences in testing a movie, playing a
timeline, and doing a publish pre-
view.Testing a movie is the easiest
way to see what the movie looks like
before it’s complete.You can see an
animation you’ve done by simply
playing the timeline.You can preview
what your movie will look like in the
browser by doing a publish preview,
which is available in the File pull-
down menu.

NOTE
Before you publish, you must save.
Use the File pull-down menu and
select Save.That way you can name
your movie and choose a directory
for it to live in. If you do not save,
you might have a hard time finding
your files after you close Flash.



When it’s actually time to do the .fla to .swf conversion, which is called publishing a movie,
you must consider several options that can be used to customize the way your movie looks
in the browser. To look at them, use the File pull-down menu to select Publish Settings.

This opens up a dialog box with several
pages of options, shown in Figure 1.19. Feel
free to look through these options, but we’ll
discuss most of them later in the book, so
I’ll leave them alone now. At this point, it’s
only important to note that on the first page
of options, labeled Formats, both the Flash
and HTML (Hypertext Markup Language)
boxes are checked. This causes Flash to cre-
ate both the .swf file that is the final movie
and an HTML document that contains it
and can be read by a Web browser. After
you click the Publish button, you can view
your movie by looking at the HTML docu-
ment it creates in your Web browser.
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Figure 1.19

Many settings can be altered to customize the way
that a movie is published.

TIP
If you want to see how your movie
will look in the browser without
going to the trouble of publishing
and then loading the HTML in your
browser, you can select Publish
Preview from the File pull-down
menu. Flash then opens your brows-
er and puts a temporary version of
your movie into it.



Conclusion
Well, we’re one chapter in, and at this point, there is no video game in sight. That’s okay,
though; making games isn’t a simple process, and we have some more ground to cover
before we’re shooting down alien invaders from Mars. We’ve covered a lot so far, though.
You should be familiar with the authoring tool and have a basic understanding of Flash
movies and how to make them. With just a little more practice and investigation, you could
be creating fantastic movies and animated sequences with the tools you are now familiar
with. But because you’re reading this book, I infer that is not your intention. Instead, you
are like me; you want to program video games. And, of course, to program, we need a pro-
gramming language. Fortunately, Flash gives us one, and its name is ActionScript.
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